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IMPORTANT SAFETY INFORMATION
All safety related and operating instructions should be read before the system is operated. Safe operation of machinery is the operators 
responsibility. Safety procedures must be posted close to the equipment and clearly visible to and legible by the operator. Safety procedures 
should meet all company and local regulations, as well as MSDS-requirements. For assistance, contact a local dealer. 

Safety Alert Symbol Definitions:
DANGER! This symbol is reserved for the most extreme situations where serious personal injury or death is imminent.

WARNING! This symbol indicates a hazardous situation that could result in serious personal injury or death.

CAUTION! This symbol indicates a hazardous situation that could result in minor or moderate personal injury. 

NOTE: This symbol addresses practices in which the operator should be aware.

GENERAL WARNINGS AND PRECAUTIONS

DANGER!
•	 Read and follow instructions. If instructions are unclear after reading the manual, please contact a local dealer.

•	 Keep children away from equipment.

•	 Do not operate machinery under the influence of alcohol or any illegal substance.

•	 Some systems include a fan heater. Never cover the heater otherwise there will be a serious danger of fire! 
WARNING! ELECTRICAL / SHOCK HAZARDS

•	 Before working on any particular component, make sure that all power supplies have been switched off and cannot be 
accidentally switched on.

•	 Disconnect power leads before using an arc welder on equipment or anything connected to the equpment.

•	 Systems including frequency drives have a risk of electric shock due to residual voltage. It is not permissible to open the 
equipment neither to disconnect the system or any quick connection until 5 minutes after the power has been removed.

•	 Only operate the system from the power source indicated in the manual. If you are not sure of the power source, consult 
qualified service personnel.

•	 Do not use a high pressure cleaner to clean electrical components. This could damage electrical components and 
subject the operator to risk of electrical shock.

•	 The electrical supply to the equipment must be properly routed and connected to the equipment. All connections must 
meet the specified requirements.

WARNING! PRESSURIZED HYDRAULIC SYSTEMS
•	 Always wear personal protective equipment (PPE) when performing work on hydraulic systems.

•	 Adhere to the machine manufacture’s approved maintenance instructions when working on the hydraulic system.

•	 Always turn equipment off when working on the hydraulic system. Take appropriate precautions when opening systems 
that have been previously pressurized.

•	 Be aware that hydraulic oil may be extremely hot and under high pressure. 



v98-05244-ENUS R2www.teejet.com

Fieldware® Link 5.02 

WARNING! CHEMICAL HANDLING
•	 Always wear PPE when handling any chemical substance. 

•	 Always follow safety labels and instructions provided by the chemical manufacturer or supplier.

•	 The operator should have full information on the nature and the quantity of the material to be distributed.

•	 ADHERE TO FEDERAL, STATE AND LOCAL REGULATIONS REGARDING THE HANDLING, USE OR DISPOSAL 
OF AGRICULTURAL CHEMICALS.

WARNING! PRESSURIZED SPRAY SYSTEM
•	 It is important to recognize proper safety precautions when using a pressurized spray system. Fluids under pressure can 

penetrate skin and cause serious personal injury. 

•	 The system pressure should never exceed the lowest rated component. Always know your system and all component 
capabilities, maximum pressures and flow rates.

•	 Filters can only be opened when the manual valves in front of and behind the filter are in closed position. If any appliance 
has to be taken out of the piping, manual valves in front of and behind this appliance have to be in closed position. If they 
are reinstalled, make sure that this happens correctly, that this apparatus is well aligned, and that all connections are 
tight. 

•	 The plumbing supply to the equipment should meet all company and local regulations and must be properly routed and 
connected to the equipment. All connections must meet the specified requirements

•	 It is advised to drain and purge the liquid train when the equipment shall not be used for a longer period of time.
WARNING! AUTO STEERING SAFETY

•	 To prevent serious personal injury or death from being run over by the vehicle or automated motion of the steering 
system, never leave the vehicles operator seat with the system engaged.

•	 To prevent serious personal injury or death from being run over by the vehicle or automated motion of the steering 
system, verify the area around the vehicle is clear of people or obstacles before startup, calibration, tuning or engaging 
the system. 

•	 Make sure equipment is tightly secured to the proper components.

•	 Never drive on public roads with system engaged.
CAUTION! EQUIPMENT SAFETY, MAINTENANCE, AND SERVICE

•	 The equipment should be operated only by properly trained, qualified personnel. They must have proven their skills in 
the operation of the equipment. 

•	 Before using the equipment, the operator has to check if the equipment is in good condition and can be used safely. If 
not, the equipment cannot be used. 

•	 All necessary PPE must be readily available to the operator at all times. 

•	 Routinely check the system and components for wear and damage. Replace or repair when necessary.

•	 Only qualified authorized experts are allowed to repair or maintain the installation. The maintenance and operating 
instructions shall be rigidly observed and followed.

•	 A complete manual for the equipment must be available to the operator or maintenance technician at all times.
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CAUTION! HARNESS CABLE AND HOSE SAFETY
•	 Routinely check all harness cables and hoses for damage or wear. Replace or repair when necessary.

•	 Do not route harness cables and hoses with sharp bends.

•	 Do not strap harness cables and hoses to lines with high vibration or spikes in pressure.

•	 Do not strap harness cables and hoses to lines transporting hot fluids.

•	 Protect harness cables and hoses from sharp objects, equipment debris, and material buildup.

•	 Allow sufficient length for harness cables and hoses to have free movement on sections that move during operation, and 
be sure that harness cables or hoses do not hang below the equipment.

•	 Allow sufficient clearance for harness cables and hoses from implement and machine operational zones.

•	 When cleaning equipment, protect harness cables from high pressure wash.
NOTE: TOUCH SCREEN CARE

•	 Keep sharp objects away from the touch screen device. Touching the screen with a sharp object could result in damage 
to the display. 

•	 Do not use harsh chemicals to clean the console/display. The correct way to clean a console/display is to use a soft 
damp cloth or anti-static wipe, similar to cleaning a monitor on a computer.

NOTE: RECOMMENDED REPLACEMENT PARTS
•	 The system has been designed with components that work together to provide the best system performance. When the 

system requires replacement parts, only TeeJet recommended components should be use to maintain proper system 
operation and safety.
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WELCOME TO FIELDWARE LINK

ABOUT FIELDWARE LINK

Fieldware Link is a data management application designed to compliment consoles manufactured by TeeJet Technologies. The application 
can be used to enhance year to year data retention and assist in future preparation. This software is for TeeJet customers using Matrix Pro G, 
Matrix Pro GS or Aeros consoles managing Job data. 

Application Purpose:
►Store Job data acquired from TeeJet consoles
►Creation and management of Machine Settings 
►Transfer Job profiles with supported Machine Settings to a 

console
►Reuse guidelines, boundaries, applied data, and ISOXML 

prescription files 

►Convert supported prescription map files into usable TeeJet 
format

	 RECOMMENDATION: Although Fieldware Link will 
support map convertion, it is recommended to use 
Fieldware Convert.

Additional Resources
Contact information for technical support, software updates, and release notes can be located at www.teejet.com.

Figure 1: Welcome Screen
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SETTING THE PROGRAM LANGUAGE

Language Selection
The program language can be changed from the Welcome Screen or in the program options.

Welcome Screen
1.	 Click the down arrow  to show list of available languages
2.	 Select preferred language
Figure 2: Language Selection – Via Welcome Screen

Program Options
1.	 Select View from the main toolbar menu
2.	 Click  Options  to open the Options page
3.	 Click Down arrow  to show list of available languages
4.	 Select preferred language
Figure 3: Language Selection – Via Options Menu 
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INTRODUCING FIELDWARE LINK

INTERFACE OVERVIEW

Fieldware Link software is designed as a record keeping supplement to the Matrix Pro and Aeros consoles. This chapter will provide an 
overview of the interface and demonstrate how to customize the workspace. Listed below are main components of the Fieldware Link 
interface.

•	 Menu Bar – provides navigation to all functions

•	 Toolbar – includes buttons for quick access to common 
commands and tools

•	 Catalog – a collection profiles used to store data

•	 Tabs – display open profiles

•	 Status Bar – indicates when a Catalog has been changed and 
not saved by displaying a black dot at the bottom of the window

Figure 4: Interface Overview

Catalog

Toolbar
Menu Bar

Status Bar

Active Tab Close Active Tab
Tab ListInactive Tab
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Menu Bar
The menu bar provides navigation to all file functions. 

Most of the menu functions can be accomplished with a click of the toolbar or right-click on the catalog.

File
The File menu contains commands that relate to managing catalogs.

NOTE:	 Jobs are created and loaded using the New Client ,  
Farm , Field  or Job  buttons, menu options, or 
catalog right-click options.

Figure 5: File Menu

Table 1: File Menu Options

Icon Description

New – creates a new Catalog

Save/Save As – saves the current open Catalog

Load – opens an existing Catalog

Page Setup – select paper size, printing source, 
page orientation and margin setup
Print Preview – displays a preview the page to be 
printed and provides the option to print

no icon
Recent – provides a list of recent Catalogs. 
Number of recent Catalogs to be shown can be 
set under View -> Options

Close – closes the Catalog

no icon Exit – closes the Fieldware Link software

Edit
The Edit menu contains commands that relate to changing a catalog 
or profiles.

►To cut, copy, paste or delete a Catalog item, highlight 
the appropriate profile on the Catalog, then choose the 
appropriate command.

Figure 6: Edit Menu

Table 2: Edit Menu Options

Icon Description
Undo/Redo – ability to step forward or step 
backward regarding recent file commands
Cut – remove selected data while creating a 
duplicate
Copy – create a duplicate of selected data while 
leaving original data in place

Paste – insert copied data from the clipboard

Delete – discard selected data
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View
The View menu provides access to profile properties, import/export 
functions, search command, calculator, the units converter tool, and 
preferences.

Figure 7: View Menu

Table 3: View Menu Options

Icon Description
Properties – access details and setup information 
for the currently selected profile
Port Profiles – export/import information from or to 
the Matrix Pro, Matrix Pro GS or Aeros consoles
Find – search for information based on a word or 
phrase
Calculator – a tool used for multiple types of 
calculations
Units Converter – convert area, length, weight, 
pressure, temperature, speed or volume from one 
unit of measurement to another

no icon
Options – set preferences such as language, units 
of measurement, recent catalog list management, 
and startup screen options

Profiles
The Profiles menu contains commands used to add profiles to a new 
or existing Catalog.

►New Farms, Fields or Job profiles will be placed under the 
selected Client. 

	 NOTE: Farm Field and Job profiles can only exist under a 
Client. However, these profiles can be reorganized under a 
currently selected Client or moved to another Client under 
the open Catalog by using the drag and drop method.

►Machine Settings can not be placed under any profile, they 
can only be associated to a Job profile under the application 
section.

Figure 8: Profiles Menu

Table 4: Profiles Menu Options

Icon Description
New Machine Settings – creates a new profile 
used to organize equipment settings
New Client – creates a new profile providing 
information regarding a person or organization
New Farm – creates a new profile under the 
selected Client that organizes a client’s farm or 
organization information

NOTE:	 If no Client is selected, the New Farm 
button will be grayed out.

New Field – creates a new profile under the 
selected farm that organizes data from separate 
fields or areas

NOTE:	 If no Farm is selected, the New Field 
button will be grayed out.

New Job – creates a new profile under the 
selected field that retains information about a 
particular assignment

NOTE:	 If no Field is selected, the New Job button 
will be grayed out.
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Window
The Window menu can be used to organize open tabs. 

Figure 9: Window Menu

Table 5: Window Menu Options

Icon Description
no icon Close Active – close only the active tab
no icon Close All – close all tabs

no icon Close All But Active – close all tabs except for the 
active tab 
Catalog – displays organization of Machine 
Settings, Clients, Farms, Fields and Job profiles

Icon varies 
based on 
the open 
window

A list of all open tabs will be listed here for viewing 
and access

Example: The Welcome screen is open in the 
above screen shot.

Help
The Help menu allows the user to obtain assistance, access 
www.teejet.com or Fieldware Link software information.

Figure 10: Help Menu

Table 6: Help Options

Icon Description

Help – opens the user manual for assistance

Website – provides a link to www.teejet.com

About – provides software version and copyright 
information 
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Toolbar
The toolbar provides quick one-click access to common menu 
functions. Hover over any button to view the button definition.

Figure 11: Toolbar one-click access

Save Catalog
Load Catalog

New Catalog

Cut
Copy

Paste

Import/Export Jobs
Show Properties

Redo
Undo New Field

New Job

New Farm
New Client

New Machine Settings

Table 7: Toolbar Options

Icon Description

New Catalog – creates a new Catalog

Load Catalog – opens an existing Catalog

Save Catalog – saves the current open Catalog

Show Properties – access Machine Settings, 
Client, Farm, Field or Job profiles
Port Profiles – export/import information between 
Fieldware Link and the Matrix Pro, Matrix Pro GS 
or Aeros consoles
New Machine Settings – creates a new profile 
used to organize equipment settings
New Client – creates a new profile providing 
information regarding a person or organization
New Farm – creates a new profile under the 
selected Client that organizes a client’s farm or 
organization information

NOTE:	 If no Client is selected, the New Farm 
button will be grayed out.

New Field – creates a new profile under the 
selected Farm that organizes data from separate 
fields or areas

NOTE:	 If no Farm is selected, the New Field 
button will be grayed out.

New Job – creates a new profile under the 
selected Field that retains information about a 
particular assignment.

NOTE:	 If no Field is selected, the New Job button 
will be grayed out.

Toolbar button functionality can also be accessed from the main 
menu. Some functions can also be found in the Catalog right-click 
options as seen below. 

Figure 12: Catalog right-click options for toolbar functions

Show Properties

New Field
New Job

Cut
Copy
Paste

New Farm
New Client

New Machine Settings
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Catalog
The Catalog is a set of profiles organized in traditional farming 
hierarchy: Machine Settings, Client, Farm, Field, and Job. The user 
may maintain multiple Catalogs, however only one Catalog can be 
open at a time. Most catalog functionality can be accessed through 
drop-down menus, the toolbar, or right-clicking on the Catalog 
window.

Figure 13: Catalog

Right-Click 
Options

Double-Click to  
View/Edit 

Properties

Client
Farm
Field
Job

Auto Hide Catalog
Catalog Options

Machine Settings

Table 8: Auto Hide Catalog & Open Tab Options

Icon Description

 
Auto Hide/Unhide – click to automatically hide or 
permanently show the Catalog when not in use

Options – provides options for closing tabs

Table 9: Catalog Tools – Right Click Tool Access

Icon Description
Properties – access catalog Machine Settings, 
Clients, Farms, Fields or Jobs profile details
Print Preview/Print – provides a preview of how 
the printed page will appear before clicking the 
print button which is also found within this option
New Machine Settings – creates a new profile 
used to organize equipment settings.
New Client – creates a new profile providing 
information regarding a person or organization
New Farm – creates a new profile under the 
selected Client that organizes a client’s farm or 
organization information

NOTE:	 If no Client is selected, the New Farm 
button will be grayed out.

New Field – creates a new profile under the 
selected Farm that organizes data from separate 
fields or areas

NOTE:	 If no Farm is selected, the New Field 
button will be grayed out.

New Job – creates a new profile under the 
selected Field that retains information about a 
particular assignment

NOTE:	 If no Field is selected, the New Job button 
will be grayed out.

Expand – expands the selected Catalog item

Collapse – collapses the selected Catalog item

Expand All – expands all current Catalog items

Collapse All – collapses all current Catalog items
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Catalog Management
Organize and manage profiles in a Catalog.
Creating a New Catalog
1.	 Click the New Catalog  button or (Ctrl N).
2.	 Begin building the catalog by creating new profiles.

Opening an Existing Catalog
1.	 Click the Load Catalog  button or (Ctrl O).
2.	 Browse and choose an existing Catalog.
3.	 Click the  Open  button.
NOTE:	 Only one Catalog can be open at a time. If a Catalog is 

already open while clicking the New or Load Catalog  
button, the program will prompt to save changes to the 
current Catalog before closing and loading a new one.

Auto Hide and Unhide the Catalog Window
•	 Click the Auto Hide Catalog  button to minimize the Catalog 

window

•	 Click the Auto Unhide Catalog  button to maximize the 
Catalog window

•	 Hover over or click the Catalog Tab in the sidebar to temporarily 
show the Catalog Window.

Figure 14: Catalog Auto Hide Button

Catalog Hide 
Button

Figure 15: Catalog Auto Unhide Button

Tab indicates 
the Catalog is 
hidden

Figure 16: Hidden Catalog

Catalog Unhide 
Button

Hover or Click 
to view Catalog
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Profile Management
View a Profile’s Properties
To view a profile for Machine Settings, Client, Farm, Field or Job:
1.	 On the catalog, double-click the Machine Settings, Client, Farm, 

Field or Job.
OR

1.	 On the catalog, highlight the Machine Settings, Client, Farm, 
Field or Job.

2.	 Click PROPERTIES  toolbar option, menu option or catalog 
right-click option.

From the properties tab you can edit the Machine Settings, Client, 
Farm, Field or Job information. If an element of a catalog has been 
edited and not saved, a black dot will appear in the lower right-hand 
corner of the window.

Figure 17: �Viewing Properties

Right-click 
option

Toolbar OptionMenu Option

Moving a Profile
►Click and drag the profile to the appropriate location.

NOTE:	 The Client, Farm, Field or Job will be added to the level 
highlighted on the Catalog, NOT the currently viewed tab. 

Creating a New Profile
Machine Settings
1.	 Click New Machine Settings  toolbar option, menu option or 

catalog right-click option 

Clients
1.	 Click New Client  toolbar option, menu option or catalog right-

click option.

Farms
1.	 On the catalog, highlight the client to which the farm is to be 

added.
2.	 Click New Farm  toolbar option, menu option or catalog right-

click option.

Fields
1.	 On the catalog, highlight the farm to which the field is to be 

added.
2.	 Click New Field  toolbar option, menu option or catalog right-

click option.

Jobs
1.	 On the catalog, highlight the field to which the job is to be added.
2.	 Click New Job  toolbar option, menu option or catalog right-

click option.
NOTE:	 Preset Catalog hierarchy will prevent the user from creating 

a profile out of order. For example: a new Field cannot be 
created without a Farm profile already existing. The hierarchy 
under Client is: Client, Farm, Field then Job. Machine 
Settings is a stand alone profile and at the same level as 
Client.
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Figure 18: New Profile Setup
Toolbar Options Menu Options

New Farm
New Client

New Job

Right-Click 
Options

New Client
New Farm
New Field
New Job

New Machine
Settings

New Field

Machine Settings

Duplicating a Profile
1.	 On the catalog, highlight the profile which is to be duplicated. 
2.	 Copy and paste the profile.

►�Option 1: Use the right click options to cut , copy , and 
paste  profiles.

►Option 2: Use the toolbar functions to cut , copy , and 
paste  profiles.

►Option 3: Use the Edit Menu options to cut , copy , and 
paste  profiles.

►Option 4: Use keyboard shortcuts to copy (Ctrl C), cut (Ctrl X), 
caste (Ctrl V) profiles.

►Option 5: Hold the “Ctrl” button on the keyboard while clicking 
and dragging to duplicate the profile and place the copied file 
the new selected position.

3.	 Place cursor where the copied profile is to be placed.
NOTE:	 Changing the description of a Job profile does not change 

how a particular Job profile is recognized by your Matrix Pro, 
Matrix Pro GS or Aeros console. If you are attempting to 
create a new Job profile, please create a copy or use the 
appropriate new Job profile option. 

Figure 19: Duplicating Properties

Right-click 
options

Toolbar OptionsMenu Options
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Deleting a Profile
1.	 Highlight the profile to be deleted in the Catalog 
2.	 Click the Delete  menu command, right click in the Catalog or 

press the Delete button on the keyboard.
NOTE:	 When deleting a Client, Farm or Field, all sub-elements of 

these [Farms, Fields or Job] will also be deleted.

Figure 20: Deleting Properties

Right-click 
option

Menu Option

Tabs
Tabs display all open profiles and allow for multiple viewing options. 

►Activate or Inactivate a Profile – click on the desired tab 
to activate a profile, all other open tabs will become gray 
indicating they are open but inactive

►Close an Active Profile – click on the close active tab  
button or right-click the active tab to close a profile

►View Tab List – click on the Tab List  button to view all open 
profiles as a list

Figure 21: Tabs Overview
Close Active Tab

Tab List
Active Tab Inactive Tab

Tab Viewing Options
Dividing the profile pane using tabs allows the user to view multiple 
profile details at one time. 

To divide the profile pane:

1.	 Click and hold the tab of the selected profile until the Divider icon 
appears.

2.	 Drag the tab and release it on the portion of the Divider  icon 
to where the profile is to be moved. The portion of the screen 
where the profile is being moved to will be highlighted.

3.	 Release the mouse button and the profile pane will be divided 
into multiple panes. Repeat as necessary.
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Figure 22: Dividing the Profile Pane – Horizontal

Figure 23: Dividing the Profile Pan – Three ways

To combine tabs into one screen section:
1.	 Click and hold on tab to be moved.
2.	 Drag the tab and release it

►on the center of the Divider icon 
►on the tab header

The screen section being combined will be highlighted.

Figure 24: Combine Tabs Into One Screen Section via Divider Icon

Figure 25: Combine Tabs Into One Screen Section via Tab Header
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Setting up Preferences
Fieldware Link is designed to allow users to customize the software. 
The Options page is where the user can set software preferences for 
language, units of measurement, messages and recent catalog list. 

To set preferences:
1.	 Open the View menu.
2.	 Click  Options .
3.	 Select from:

►Language – set preferred language
	 * Languages included in the program may be changed at any time.

►Units – choose program measurement preference (area, 
length, weight, pressure, temperature, speed, and volume)

►Preferences – define startup options
►Messages – reset all suppressed messages (those which 

have been marked as, “Do not show again”)
►Recent Catalog List – establish the number of Catalogs listed 

in the Recent Catalog List as well as clear Catalog history 
from the Recent Catalog List

NOTE:	 Any changes made under the View -> Options menu are 
considered a global change and not Job specific. Example: if 
the user changes pressure units from psi to bar, all jobs will 
be converted to bar until the user makes the change in the 
View -> Options menu.

NOTE: Any imported job will assume the f

Figure 26: Options Menu

Language Selection
Preferred language can be chosen from either from the Welcome 
screen or in the Language section on the Options page.

Welcome Screen
1.	 Click the down arrow  to show list of available languages
2.	 Select preferred language
Figure 27: Language Selection – Via Welcome Screen

Program Options
1.	 Select View from the main toolbar menu
2.	 Click  Options  to open the Options page
3.	 Click Down arrow  to show list of available languages
4.	 Select preferred language
Figure 28: Language Selection – Via Options Menu 
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Units of Measurement
Area, length, weight, pressure, temperature, speed, and volume units 
can be customized by the user. 

NOTE: A change in this section will globally change all units of 
measurment throughout the Catalog.

Figure 29: Units of Measurement Preferences

Startup Screen Preferences
A Welcome screen will appear upon startup. Language selection is 
available on this page.

The Welcome screen can be disabled so it doesn’t open upon 
startup. This option is located under the Preferences section on 
the Options page. Depending on the user’s preference, uncheck or 
check the Show Welcome on Startup box.

Figure 30: Welcome Screen

Figure 31: Startup Screen Preferences
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Alert Messages
The user has the option to reset all suppressed messages back 
to default settings. Suppressed messages are defined as any pop 
up messages that have been marked as “Do not show again”. 
Messages preferences can be changed in the Messages section on 
the Options page. 

Figure 32: Messages Preferences

Recent Catalog List
Recent Catalog List provides easy access to the most recently 
opened files can be accessed under File -> Recent. 

To manage Recent Catalog List preferences, navigate to 
View -> Options -> Recent Catalog List.

•	 By typing in a number or using the arrow button, the user 
can choose how many files can be displayed under the 
File- > Recent menu.

•	 By clicking the  Clear  button, the user can clear the list of all 
files shown under File -> Recent.

Figure 33: Managing Recent Catalog List Options

Figure 34: Recent Catalog List

Figure 35: Recent Catalog List Reset Message
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WORKING WITH PROFILES
Profiles are records that make up a Catalog. Client, Farm, Field, Job, and Machine Settings are referred to as profiles in Fieldware Link. 
Profiles are designed for record keeping and job preparation between Fieldware Link and Matrix Pro/Aeros. This section demonstrates how to 
setup, manage, and utilize profile settings. 

CATALOG AND PROFILES

The Catalog is located on the left hand side of the Fieldware Link 
window. All profiles associated with the open Catalog will be listed in 
traditional farming hierarchy: Client, Farm, Field, and Job. Machine 
Settings is also placed at the top hierarchical level. Because a 

Machine Settings profile can be can be applied to multiple Job 
profiles, it is placed at the same hierarchical level as Client within the 
Catalog.

Figure 36: Catalog and Profile Hierarchy Example

Machine 
Settings

Client
Farm
Field
Job

Catalog
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UTILIZING PROFILE RECORDS

 Job Profile
A Job profile stores information that can be transferred to and from 
the Matrix Pro G, Matrix Pro GS or Aeros console.

►Profile image and information quick view
►Description – names the Job profile

	 NOTE: �Changing the description of a Job profile does not 
change how it is recognized by the console.

►Application
◄Machine Settings – a drop down menu of defined Machine 

Settings Profiles to which the user can choose
◄Overlap – available only with Machine Settings selected 

and is pulled from Machine Settings profile
◄Product Name – a place to track the brand name of product
◄Tank/Bin Amount – volume of product used on the job
◄Application Type – enters the type of product to be applied 

- options are liquid or granular
◄Target Application Rate Preset –  presets application rate 

for up to three (3) Target Application Rates - range is 0.00 
to 100000

◄Tip Constant – sets an application rate according to the 
current TeeJet tip – range 0.00 to 100.00

◄Ground Speed Override (GSO) – sets the minimum speed 
used for automatic application rate control. When the 
vehicle speed falls below this setting, GSO speed is used 
to control the application rate, rather than the actual ground 
speed - range is 0.00 to 223.69 mph / 0.00 to 360.00 km/h

►Notes – a place to record specific information not mentioned 
in the predefined fields

►Maps and Information – options will appear in this section if 
applicable to the active job

	 NOTE: For more details on maps, see Application Mapping.

◄Boundaries – application boundaries establish areas where 
product is and is not applied while using ASC or BoomPilot. 
On the Matrix Pro G, Matrix Pro GS or Aeros console, 
boundaries can be established in all guidance modes. One 
exterior boundary and up to five (5) interior boundaries can 
be stored at one time. A boundary cannot be drawn; it must 
be established on a console or provided in a third-party 
prescription map. 
 View  – select to view the boundary(s) on a map and use 
the Measure Distances tool 
 Delete  – select to delete all boundaries in the current job 
profile

◄Guidelines – AB guidelines, Azimuth guidelines, next 
pass guidelines, and NextRow guidelines are each 
available depending on the current guidance mode on the 
Matrix Pro G, Matrix Pro GS or Aeros console. Up to 25 
established guidelines can be stored in the console per job.  
 Add  – select to open the existing boundary or map in 
the location of the deleted boundary to add new guideline 
information 
 Edit  – select to edit an existing guideline(s) on a map or 
add a straight AB or curved AB guideline(s) 
 Delete  – select to delete all guidelines in the current job 
profile

◄Prescription Maps – a pre-loaded map that provides 
information to the rate controller for use in applying 
product. Prescription Maps contain geo-referenced product 
rate information. The Aeros console can import job data 
containing Prescription Maps for use with variable rate 
application (VRA) using compatible rate controllers. 
 Import  – select to load a new prescription map 
 Add  – select to open the existing boundary to add 
prescription information to the existing boundary 
 Edit  – select to edit the existing prescription map 
 Delete  – select to delete the existing prescription map

◄Applied Data – applied data is a record of areas covered by 
the implement and how much and where product has been 
applied.  
 Export  – select to export the applied data record to an 
XML file to be used for other external mapping options 
 View  – select to view the applied data on a map and use 
the Measure Distances tool 
 Delete  – select to delete all applied data in the current job 
profile

◄Tip Faults – when a Tip Flow Monitor Kit is present on an 
Aeros system, a Tip Flow Monitor is available. After the tips 
are balanced, the system will monitor all the tips and their 
the flow rate if their respective boom section is turned on. 
The flow rate of each tip must be within the percentage 
range. If any tip is outside this range, an error will be 
generated, and the user will need to inspect the tip that is at 
fault. These faults are recorded and available to be viewed 
on a map. 
 View  – select to view the tip faults on a map and use the 
Measure Distances tool 
 Delete  – select to delete all tip faults in the current job 
profile

►Associated Profile(s) – displays associated profiles - double-
click the image to open the associated profile
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Figure 37: Job Profile Sample on Console

NOTE:	 While porting information from the software to the console, 
some information may be stored in the background and not 
displayed until transferred back into the software.

Figure 38: Job Profile Sample in Fieldware Link

Associated Profile(s)
(double click the image 
to open the associated 
profile)

NOTE:	 Under a Job Profile, the user can delete map information 
from a specific job, such as Boundaries, Guidelines, 
Prescription Map, Applied Data, and Tip Faults. The edited 
job can then be reused by importing back into the supported 
console.



2098-05244-ENUS R2www.teejet.com

Fieldware® Link 5.02 

Duplicating a Job Profile for Reuse
A Job profile can be duplicated for reuse, allowing the user to apply 
boundary and guideline data from an existing Job profile into a future 
Job profile within the same field.

To duplicate a Job:
1.	 On the Catalog, highlight the Job profile.
2.	 Choose Copy 
3.	 Choose Paste 
4.	 Edit the newly created Job profile’s description.

NOTE:	 The copied Job profile retains the original Job name, it 
is suggested to rename the job indicating duplication 
(example: JobName_copy).

5.	 Edit the Application settings as needed.

6.	 Edit the Maps and Information options including boundaries, 
guidelines, applied data, prescription maps, and tip faults as 
needed.
►To apply an application to an area more than once using 

established Boundaries, Guidelines, and Prescription Map, 
 Delete  the Applied Data and Tip Faults.

►To only reuse an established guideline such as an azimuth 
degree line,  Delete  the Applied Data, Boundaries, 
Prescription Map, and Tip Faults.

►To only reuse an established boundary,  Delete  the Applied 
Data, Guidelines, Prescription Map, and Tip Faults.

7.	 Save the Catalog.
Export the duplicated Job to a USB drive for use in the Matrix Pro G, 
Matrix Pro GS or Aeros console.

Figure 39: Copy and Paste – Toolbar, Menu and Right–Click Options

Right-Click Options
Copy

Paste

Paste
Copy

Toolbar Options

Menu Options
Copy
Paste

Delete 
Buttons
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 Machine Settings Profile
A Machine Settings profile is used for storing and transferring 
detailed information about vehicle and implement settings between 
Fieldware Link and the console. Basic Properties, Implement 
Dynamics and Job Specific Default entries can be imported from user 
defined or edited Machine Settings from Aeros or Matrix Pro GS v3.xx 
and newer console.

Creating a Machine Settings Profile
To create a new Machine Settings profile, either create a copy or a 
new Machine Settings profile. Changing the description of a Machine 
Settings profile does not change how a particular Machine Settings 
profile is recognized by the Aeros, or Matrix Pro GS, console. 

NOTE:	 Because a Machine Settings profile can be can be applied 
to multiple Job profiles, it is placed at the same hierarchical 
level as Client within the Catalog. Machine Settings can be 
linked to any Job profile by choosing an established Machine 
Settings profile from the drop down menu on the Job profile 
screen.

Standard Profile Sections
►Profile image and information quick view.
►Basic Properties – defines implement information and 

measurements.
►Unit Overrides – defines any measurement units that should 

vary from those listed in Fieldware Link.
►Implement Dynamics – depending on Basic Properties section 

setup, defines specifics for sections and delay on/off times.
►Job Specific Defaults – defines application specific 

information.
►Input Output Module (IOM) Pressure Sensor – defines 

pressure sensor information.
NOTE:	 Depending on information entered by the user, available 

options may vary for Basic Properties, Implement Dynamics 
and Job Specific Defaults sections.

Figure 40: Machine Settings Profile Sample in Fieldware Link
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Defining Implement Types
Under the Basic Properties section the user defines Implement 
Type by selecting the type of application pattern that most closely 
represents the users system. 

►Straight – the boom sections have no length and are on a line 
a fixed distance from antenna

►Spreader – a virtual line is created in line with the delivery 
disks from which the application section or sections can vary 
in length and can be at different distances from the line

►Staggered – a virtual line is created in line with section one (1) 
from which the application section or sections have no length 
and can be at different distances from the line

Sections are numbered from left to right while facing in the machine’s 
forward direction. 

Figure 41: Implement Type – Straight
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Figure 42: Implement Type – Spreader
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Figure 43: Implement Type – Staggered
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Straight Implement Type
Basic Properties

►Description – names the Machine Settings profile
►GNSS Antenna Height – measures the antenna height from 

the ground - range is 0.0 to 32.81 feet / 0.0 to 10.0 meters
►Guidance Width – enters the distance between the guidelines 

- range is 3.28 to 246.06 feet / 1.0 to 75.0 meters
►Implement Type – selects  Straight  as the layout of the 

sections for the applied product location
►Lateral Implement Offset Direction  – selects the lateral 

direction (left or right) from the centerline of the machine to the 
center of the implement while facing in the machine’s forward 
direction

►Lateral Implement Offset Distance  – defines the lateral 
distance from the centerline of the machine to the center 
of the implement - range is 0.00 to 164.04 feet / 0.00 to 
50.00 meters

►In-line Implement Offset Direction  – selects whether the 
implement is located in front of or behind the GNSS antenna 
as the vehicle moves in a forward direction

►In-line Implement Offset Distance  – defines the in-line 
distance from the GNSS antenna to the implement – range is 
0.00 to 164.04 feet / 0.00 to 50.00 meters

►Number of Implement Sections – selects the number of 
implement sections – range is 1 to 15 sections

►Tank/Bin Capacity – enters the capacity of the tank 
or bin - range is 0.00 to 264,172.052 gallons / 0.00 to 
1,000,000.00 liters

►Automatic Section Control (ASC) – when enabled, Delay Time 
options, and Overlap percentage options become available

►Aeros/DCM Rate Control – when enabled, rate controller 
options become available

Figure 44: Implement Offset Distance and Direction
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Unit Overrides
►Volume – selects unit of measurement to override the volume 

units from Fieldware Link options. This override only affects 
this Machine Settings profile

Implement Dynamics
►Delay On Time [when ASC is enabled] – used to set the time 

when the section will switch on when entering an area that 
has not been applied - range is 0 to 10 seconds
NOTE:	 If the application turns on too soon when entering an 

unapplied area, decrease the Delay On time. If the 
application turns on too late, increase the Delay On 
time.

►Delay Off Time [when ASC is enabled] – used to set the time 
when the section will switch off when entering an area that 
has been applied - range is 0 to 10 seconds
NOTE:	 If the application turns off too soon when entering an 

unapplied area, decrease the Delay Off time. If the 
application turns off too late, increase the Delay Off 
time.

►Symmetric Implement Layout – used to establish if sections 
are paired and therefore share the same Section Width values

►Section Width – used to enter the width of each section of the 
implement. Each section can be a different width – range for 
each section is 0.0 to 246.06 feet / 0.0 to 75.0 meters
NOTE:	 Total for all sections must be greater than 3.28 feet / 

1.0 meter

NOTE:	 Sections are numbered from left to right while facing 
in the machine’s forward direction.

Job Specific Defaults
►Overlap [when ASC is enabled] – selects the amount of 

overlap allowed when the sections are turned on and off - 
options are 0%, 50%, and 100%

Figure 45: Overlap Illustration for Straight Implement Type
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►Application Type – enters the type of product to be applied - 
options are liquid or granular

►Target Application Rate Preset – presets application rate for 
up to three (3) Target Application Rates - range is 0.00 to 
100000

►Tip Constant – sets an application rate according to the 
current TeeJet tip – range 0.00 to 100.00

►Ground Speed Override (GSO) – sets the minimum speed 
used for automatic application rate control. When the vehicle 
speed falls below this setting, GSO speed is used to control 
the application rate, rather than the actual ground speed - 
range is 0.00 to 223.69 mph / 0.00 to 360.00 km/h

Input Output Module (IOM) Pressure Sensor
►Maximum Pressure Rating – used to establish the maximum 

pressure rating of the pressure sensor as recommended by 
the manufacturer - range is 1.45 to 435.11 psi / 0.00 to 30.00 
bar

►Low Pressure Alarm – used to enter the user determined low 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar

►High Pressure Alarm – used to enter the user determined high 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar
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Figure 46: Straight Implement Type Spreader Implement Type – TeeJet Option
NOTE:	 When loading this profile type onto a console without a 

Smartcable or SDM on the system, only values for Section 1 
will be used. All other section or ASC information will be 
retained in the background as unused parts of the profile.

	 Loading a spreader implement type onto a console that has 
not had the spreader ASC feature unlocked is not permitted.

	 The machine settings for multiple-section spreader 
applications are machine dependent. Please consult with the 
spreader manufacturer, and not TeeJet, for these machine 
specific settings.

Basic Properties
►Description – names the Machine Settings profile
►GNSS Antenna Height – measures the antenna height from 

the ground - range is 0.0 to 32.81 feet / 0.0 to 10.0 meters
►Guidance Width – enters the distance between the guidelines 

- range is 3.28 to 246.06 feet / 1.0 to 75.0 meters
►Implement Type – used to select  Spreader  as the layout of 

the sections for the applied product location 
►Lateral Implement Offset Direction  – selects the lateral 

direction (left or right) from the centerline of the machine to the 
center of the implement while facing in the machine’s forward 
direction

►Lateral Implement Offset Distance  – defines the lateral 
distance from the centerline of the machine to the center 
of the implement - range is 0.00 to 164.04 feet / 0.00 to 
50.00 meters

►Antenna to Disks Distance  – enters the distance from the 
GNSS antenna to the delivery disks or dispersal mechanism – 
range is 0.0 to 164.04 feet / 0.0 to 50.0 meters

►Number of Implement Sections – selects the number of 
implement sections – range is 1 to 15 sections

►Tank/Bin Capacity – enters the capacity of the tank 
or bin - range is 0.00 to 264,172.052 gallons / 0.00 to 
1,000,000.00 liters

►Automatic Section Control (ASC) – when enabled, Delay Time 
options, and Overlap percentage options become available

►Aeros/DCM Rate Control – when enabled, rate controller 
options become available

Unit Overrides
►Volume – selects unit of measurement to override the volume 

units from Fieldware Link options. This override only affects 
this Machine Settings profile
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Figure 47: Lateral Offset Direction and Distance – Single Section

Figure 48: Lateral Offset Direction and Distance – Multiple Section

Implement Dynamics
►Setup Type – used to select either  TeeJet  spreader type 
►Delay On Time [when ASC is enabled] – used to set the time 

when the section will switch on when entering an area that 
has not been applied - range is 0 to 10 seconds
NOTE:	 If the application turns on too soon when entering an 

unapplied area, decrease the Delay On time. If the 
application turns on too late, increase the Delay On 
time.

►Delay Off Time [when ASC is enabled] – used to set the time 
when the section will switch off when entering an area that 
has been applied - range is 0 to 10 seconds
NOTE:	 If the application turns off too soon when entering an 

unapplied area, decrease the Delay Off time. If the 
application turns off too late, increase the Delay Off 
time.

►Spread Offset Distance  – used to set the distance between 
the disks or dispersal mechanism and where product initially 
hits the ground on Section 1 – range is 0.0 to 246.06 feet / 0.0 
to 75.0 meters

►Symmetric Implement Layout – establishes if sections are 
paired and therefore share the same Section Width, Section 
Offsets, and Section Lengths values.

►Section Width – enters the width of each section of the 
implement – range for each section is 0.0 to 246.06 feet / 0.0 
to 75.0 meters
NOTE:	 Total for all sections must be greater than 3.28 feet / 

1.0 meter. Each section can be a different width.

NOTE:	 Sections are numbered from left to right while facing 
in the machine’s forward direction.

►Section Lengths  – used to set the length of application in 
each section – range for each section is 0.0 to 246.06 feet / 
0.0 to 75.0 meters. 
NOTE:	 Each section can be a different length.

NOTE:	 Sections are numbered from left to right while facing 
in the machine’s forward direction. 

►Section Offsets  – used to set the offset distance from 
Section 1 (the Spread Offset line) to the leading edge of 
each section, Section 1 is always 0, all other sections can be 
different distances
NOTE:	 The Section Offsets option is only available when 

multiple sections are engaged.

Figure 49: Distances and Length – Single Section

Figure 50: Distances and Length – Multiple Section
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Job Specific Defaults
►Overlap [when ASC is enabled] – selects the amount of 

overlap allowed when the sections are turned on and off - 
options are 0%, 50%, and 100%

Figure 51: Overlap Illustration for Spreader Implement Type
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►Application Type – enters the type of product to be applied - 
options are liquid or granular

►Target Application Rate Preset – presets application rate for 
up to three (3) Target Application Rates - range is 0.00 to 
100000

►Tip Constant – sets an application rate according to the 
current TeeJet tip – range 0.00 to 100.00

►Ground Speed Override (GSO) – sets the minimum speed 
used for automatic application rate control - when the vehicle 
speed falls below this setting, GSO speed is used to control 
the application rate, rather than the actual ground speed - 
range is 0.00 to 223.69 mph / 0.00 to 360.00 km/h

Input Output Module (IOM) Pressure Sensor
►Maximum Pressure Rating – used to establish the maximum 

pressure rating of the pressure sensor as recommended by 
the manufacturer - range is 1.45 to 435.11 psi / 0.00 to 30.00 
bar

►Low Pressure Alarm – used to enter the user determined low 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar

►High Pressure Alarm – used to enter the user determined high 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar

Figure 52: Spreader Implement Type
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Spreader Implement Type – OEM
Basic Properties

►Description – names the Machine Settings profile
►GNSS Antenna Height – measures the antenna height from 

the ground - range is 0.0 to 32.81 feet / 0.0 to 10.0 meters
►Guidance Width – enters the distance between the guidelines 

- range is 3.28 to 246.06 feet / 1.0 to 75.0 meters
►Implement Type – selects  Spreader  as the layout of the 

sections for the applied product location
►Lateral Implement Offset Direction  – selects the lateral 

direction (left or right) from the centerline of the machine to the 
center of the implement while facing in the machine’s forward 
direction

►Lateral Implement Offset Distance  – defines the lateral 
distance from the centerline of the machine to the center 
of the implement - range is 0.00 to 164.04 feet / 0.00 to 
50.00 meters

►Antenna to Disks Distance – enters the distance from the 
GNSS antenna to the delivery disks or dispersal mechanism - 
range is 0.0 to 164.04 feet / 0.0 to 50.0 meters

►Number of Implement Sections – selects the number of 
implement sections – range is 1 to 15 sections

►Tank/Bin Capacity – enters the capacity of the tank 
or bin - range is 0.00 to 264,172.052 gallons / 0.00 to 
1,000,000.00 liters

►Automatic Section Control (ASC) – when enabled, Delay Time 
options, and Overlap percentage options become available

►Aeros/DCM Rate Control – when enabled, rate controller 
options become available

Unit Overrides
►Volume – selects unit of measurement to override the volume 

units from Fieldware Link options. This override only affects 
this Machine Settings profile

Implement Dynamics
►Setup Type – selects  OEM  spreader type 
►Start Distance – sets the start distance when exiting an 

applied area (consult spreader manufacturer for value)
►Stop Distance – sets the stop distance when entering an 

applied area
NOTE:	 Consult spreader manufacturer for start and stop 

distances.

►Symmetric Implement Layout – used to establish if sections 
are paired and therefore share the same Section Width, 
Section Offsets, and Section Lengths values

►Section Width – used to enter the width of each section of the 
implement – range for each section is 0.0 to 246.06 feet / 0.0 
to 75.0 meters
NOTE:	 Total for all sections must be greater than 3.28 feet / 

1.0 meter. Each section can be a different width.

NOTE:	 Sections are numbered from left to right while facing 
in the machine’s forward direction.

►Section Start Offsets – sets the offset distance from Section 1 
to the leading edge of each section, Section 1 is always 0 - all 
other sections can be different distances

►Section Stop Offsets – sets the offset distance from Section 
1 to the trailing edge of each section - each section can be a 
different distance
NOTE:	 Consult spreader manufacturer for section start and 

stop offset values. Sections are numbered from left to 
right while facing in the machine’s forward direction.

Job Specific Defaults
►Overlap [when ASC is enabled] – selects the amount of 

overlap allowed when the sections are turned on and off - 
options are 0%, 50%, and 100%

►Application Type – enters the type of product to be applied - 
options are liquid or granular

►Target Application Rate Preset – presets application rate for 
up to three (3) Target Application Rates - range is 0.00 to 
100000

►Tip Constant – sets an application rate according to the 
current TeeJet tip – range 0.00 to 100.00

►Ground Speed Override (GSO) – sets the minimum speed 
used for automatic application rate control - when the vehicle 
speed falls below this setting, GSO speed is used to control 
the application rate, rather than the actual ground speed - 
range is 0.00 to 223.69 mph / 0.00 to 360.00 km/h

Input Output Module (IOM) Pressure Sensor
►Maximum Pressure Rating – used to establish the maximum 

pressure rating of the pressure sensor as recommended by 
the manufacturer - range is 1.45 to 435.11 psi / 0.00 to 30.00 
bar

►Low Pressure Alarm – used to enter the user determined low 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar

►High Pressure Alarm – used to enter the user determined high 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar



2898-05244-ENUS R2www.teejet.com

Fieldware® Link 5.02 

Figure 53: Spreader Implement Type – OEM Staggered Implement Type
NOTE:	 When loading this profile type onto a console without a 

Smartcable or SDM on the system, only values for Section 1 
will be used and the implement type will be set to “Straight”. 
All other section or ASC information will be retained in the 
background as unused parts of the profile.

Basic Properties
►Description – names the Machine Settings profile
►GNSS Antenna Height – measures the antenna height from 

the ground - range is 0.0 to 32.81 feet / 0.0 to 10.0 meters
►Guidance Width – enters the distance between the guidelines 

- range is 3.28 to 246.06 feet / 1.0 to 75.0 meters
►Implement Type – selects  Staggered  as the layout of the 

sections for the applied product location. 
►Lateral Implement Offset Direction  – selects the lateral 

direction (left or right) from the centerline of the machine to the 
center of the implement while facing in the machine’s forward 
direction

►Lateral Implement Offset Distance  – defines the lateral 
distance from the centerline of the machine to the center 
of the implement - range is 0.00 to 164.04 feet / 0.00 to 
50.00 meters

►In-line Section 1 Offset Direction  – selects whether Section 
1 (the zero-point of the Section Offsets) is located in front of or 
behind the GNSS antenna as the vehicle moves in a forward 
direction

►In-line Section 1 Offset Distance  – defines the in-line 
distance from the GNSS antenna to Section 1 (the zero-point 
of the Section Offsets)

►Number of Implement Sections – selects the number of 
implement sections – range is 1 to 15 sections

►Tank/Bin Capacity – enters the capacity of the tank 
or bin - range is 0.00 to 264,172.052 gallons / 0.00 to 
1,000,000.00 liters

Figure 54: Offset Directions and Distances – in front of section 1
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Figure 55: Offset Directions and Distances – behind section 1

Unit Overrides

►Volume – selects unit of measurement to override the volume 
units from Fieldware Link options. This override only affects 
this Machine Settings profile

Implement Dynamics
►Delay On Time [when ASC is enabled] – used to set the time 

when the section will switch on when entering an area that 
has not been applied - range is 0 to 10 seconds
NOTE:	 If the application turns on too soon when entering an 

unapplied area, decrease the Delay On time. If the 
application turns on too late, increase the Delay On 
time.

►Delay Off Time [when ASC is enabled] – used to set the time 
when the section will switch off when entering an area that 
has been applied - range is 0 to 10 seconds
NOTE:	 If the application turns off too soon when entering an 

unapplied area, decrease the Delay Off time. If the 
application turns off too late, increase the Delay Off 
time.

►Symmetric Implement Layout – used to establish if sections 
are paired and therefore share the same Section Width and 
Section Offsets values

►Section Width – used to enter the width of each section of the 
implement – range for each section is 0.0 to 246.06 feet/ 0.0 
to 75.0 meters
NOTE:	 Total for all sections must be greater than 3.28 feet / 

1.0 meters. Each section can be a different width.

NOTE:	 Sections are numbered from left to right while facing 
in the machine’s forward direction.

►Section Offsets  – used to set the offset distance from 
Section 1 (the In-Line Section 1 Offset Distance line) to each 
section. A positive offset value will move the section behind 
Section 1. A negative offset value will move the section in front 
of Section 1. Section 1 is always 0. All other sections can be 
different distances.

NOTE:	 The Section Offsets option is only available when 
multiple sections are engaged.

Job Specific Defaults
►Overlap [when ASC is enabled] – selects the amount of 

overlap allowed when the sections are turned on and off - 
options are 0%, 50%, and 100%

Figure 56: Overlap Illustration for Staggered Implement Type

100%50%0%

►Application Type – enters the type of product to be applied - 
options are liquid or granular

►Target Application Rate Preset – presets application rate for 
up to three (3) Target Application Rates - range is 0.00 to 
100000

►Tip Constant – sets an application rate according to the 
current TeeJet tip – range 0.00 to 100.00

►Ground Speed Override (GSO) – sets the minimum speed 
used for automatic application rate control - when the vehicle 
speed falls below this setting, GSO speed is used to control 
the application rate, rather than the actual ground speed - 
range is 0.00 to 223.69 mph / 0.00 to 360.00 km/h

Input Output Module (IOM) Pressure Sensor
►Maximum Pressure Rating – used to establish the maximum 

pressure rating of the pressure sensor as recommended by 
the manufacturer - range is 1.45 to 435.11 psi / 0.00 to 30.00 
bar

►Low Pressure Alarm – used to enter the user determined low 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar
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►High Pressure Alarm – used to enter the user determined high 
pressure point at which the alarm will sound - range is 0.00 to 
1450.38 psi / 0.00 to 100.00 bar

Figure 57: Staggered Implement Type
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 Client Profile
A Client profile stores detailed information about a Client and/
or business. The Client name can be seen on the Console when 
importing a Job associated with it. 

►Profile image and information quick view
►Name – lists detailed information such as Title, Full Name, 

Suffix and Display As preference
►Business – lists business information such as business name, 

job name and tax ID
►Address – records address information
►Contact – records contact information and sets contact 

preferences - click the Go To  button to send an e-mail or 
access their website

►Notes – records specific information not mentioned in the 
predefined fields

►Associated Profile(s) – displays associated profiles - double-
click the image to open the associated profile

Figure 58: Client Profile Sample on Console

Figure 59: Client Profile Sample in Fieldware Link

Associated Profile(s)
(double click the image 
to open the associated 
profile)
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 Farm Profile
A Farm profile stores specific physical details about a Farm.

►Profile image and information quick view
►Description – names the Farm profile
►Area – records measurements of a piece of ground specified 

by three (3) options: Mapped, Tillable and Legal (user defined 
properties – not pulled from Jobs on the console)

►Notes – records specific information not mentioned in the 
predefined fields

►Associated Profile(s) – displays associated profiles - double-
click the image to open the associated profile

Figure 60: Farm Profile Sample on Console

Figure 61: Farm Profile Sample in Fieldware Link

Associated Profile(s)
(double click the image 
to open the associated 
profile)
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 Field Profile
A Field profile stores descriptive and physical information about a 
field.

NOTE:	 All values entered in any “Name” fields under Farm 
Association or Legal sections of a Field profile will be the 
same throughout the entire Catalog in all Field profiles. 

►Profile image and information quick view
►Description – name the profile
►Area – measurement of a piece of ground specified by 

three (3) options: Mapped, Tillable and Legal (user defined 
properties – not pulled from Jobs on the console)

►Farm Association Information – User defined entries. 
►Legal Information – User defined entries. 
►Notes – a place to record specific information not mentioned 

in the predefined fields
►Associated Profile(s) – displays associated profiles - double-

click the image to open the associated profile
Figure 62: Field Profile Sample on Console

Figure 63: Field Profile Sample in Fieldware Link

Associated Profile(s)
(double click the image 
to open the associated 
profile)
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IMPORTING/EXPORTING

Profiles for Jobs and Machine Settings can be imported or exported 
to a USB drive for use with the Matrix Pro, Matrix Pro GS or Aeros 
consoles. See the appropriate user manual specific to the console 
software version for details on importing and exporting (called 
transfer) on the console. 

To open the Port Profiles tab:
1.	 Click Port Profiles  toolbar option or View -> Port Profiles 

menu option.
2.	 Select the console model from the drop-down menu:

►Matrix Pro 570/840 v2.xx – Includes both Matrix Pro and 
Matrix Pro GS consoles running software version 2.xx. 
Machine Settings are unsupported and will not be included in 
a port. 

►Matrix Pro 570/840 v3.xx – Includes consoles running 
software version 3.xx and newer. All settings are supported.

►Aeros or Matrix Pro 570/840 v4.xx – Includes consoles 
running software version 4.xx and newer. All settings are 
supported. 

3.	 Select the USB drive.
4.	 Click  OK .
Figure 64: Import/Export

Toolbar OptionMenu Option

Figure 65: Port Drop-down Menu Options

Exporting Profiles to a Console
NOTE:	 Exporting a Job profile or a Client/Farm/Field profile 

containing a Job profile to a USB drive will remove the Job 
from the Catalog.

To export a profile to the Matrix Pro, Matrix Pro GS, or Aeros:
1.	 Access the Port Profiles  button.
2.	 On the catalog, highlight the profile to be exported.

◄Machine Settings, copy a specific profile 
◄Job, move a specific Job
◄Field, move all Jobs associated with the selected Field.
◄Farm, move all Jobs associated with the selected Farm.
◄Client, move all Jobs associated with the selected Client.

3.	 Click Export Profile button  or click and drag the profile to the 
import/export tab.

4.	 Repeat steps 1 to 2 as needed for other profiles.
5.	 Click  Done .
6.	 Remove USB drive.
7.	 Insert USB drive into Matrix Pro, Matrix Pro GS or Aeros console.
8.	 Follow instructions for the specific console software version.
Figure 66: Exporting Profiles to the Console

Export Profile

Import/Export Tab
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Jobs with Associated Machine Settings
If a Job profile has Machine Settings associated, a copy of the 
Machine Settings will also be exported. Along with transferring the 
Job profile to the Matrix Pro GS, or Aeros v4.xx and newer console, 
the Machine Settings profile may be transferred into the Matrix Pro 
GS, or Aeros.

NOTE:	 When exporting and importing, stored information may 
not be visible on console. This information is not deleted, 
instead it is kept in the background until imported back into 
Fieldware Link.

Figure 67: Job Application Settings

Figure 68: Exporting Job with Associated Machine Settings

Importing Profiles from the Console
If a Job (or Jobs) being imported has not been created or edited in 
Fieldware Link, it will be placed in a new Client (named “Unknown”) 
within the catalog. The imported Job(s) can be manually moved to a 
different Client, Farm or Field; or the new Client, Farm and Field can 
be edited and saved.

Changing the description of a Job or Machine Settings profile does 
not change how it is recognized by the Matrix Pro, Matrix Pro GS 
or Aeros console. If you change the name and port the profile to 
the Matrix Pro, Matrix Pro GS, or Aeros console, it will override the 
previous profile with the renamed profile.

NOTE:	 Porting a profile from a USB drive to the catalog will remove 
it from the USB drive.

To import a profile back into the catalog:
1.	 Follow instructions for the specific console software version to 

transfer the profiles to a USB drive.
2.	 Access the Port Profiles  button.
3.	 From the USB drive window, highlight the profiles to be merged.

◄The Machine Settings profile, to move a specific profile.
◄The Job, to move a specific Job.
◄The Field, to move all Jobs associated with the selected Field.
◄The Farm, to move all Jobs associated with the selected 

Farm.
◄The Client, to move all Jobs associated with the selected 

Client.
4.	 Either click the MERGE SELECTED button , right-click and 

choose MERGE  or click and drag to the catalog*.
5.	 Repeat steps 1 to 2 as needed for other profiles (only one can be 

selected at a time).
6.	 Click  DONE .
7.	 Remove USB drive.
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NOTE:	 *Clicking and dragging into the catalog will place the Job 
where dropped – not where it was associated on the USB 
drive.

To merge all Jobs back into the catalog:
1.	 Follow instructions for the specific console software version to 

transfer the profiles to a USB drive.
2.	 Access the Port Profiles  tab.
3.	 Click Merge All Into Catalog  button.
4.	 Click  Done .
5.	 Remove the USB drive.
NOTE:	 If the user fails to click the  Done  button to complete a 

transfer, a warning window will pop up to inform the user of 
possible damaged to data.

Figure 69: Warning Message

Figure 70: �Importing Job Data from the Console
Right-Click Option

Merge

Merge Selected Into Catalog
Merge All Into Catalog

Import/Export Tab

Figure 71: Completeing a Transfer by clicking the Done button.
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APPLICATION MAPPING
 

ACCESSING MAPS

To access a map:

1.	 View a Job Profile with mapping data from the catalog.
2.	 Select from the following:

►Boundaries – select  View  to view the boundary(s) on a map 
and use the Measure Distances tool

►Guidelines – select  Add  to open the existing boundary 
or map in the location of the deleted boundary to add new 
guideline information or  Edit  to edit an existing guideline(s) 
on a map or add a straight AB or curved AB guideline(s)

►Prescription Maps – select  Add  to open the existing 
boundary to add prescription information to the existing 
boundary or  Edit  to edit the existing prescription map

►Applied Data – select  View  to view the applied data on a 
map

►Tip Faults – select  View  to view the tip faults on a map
3.	 Click the SAVE button  if edits have been made to a guideline 

or prescription map.

Figure 72: Example of Options on a Job Profile

OVERVIEW

Boundaries, guidelines, applied data, and prescription mapping can be copied from one job to another, eliminating the need to re-record field 
boundaries and information. The ability to reuse guidelines means work patterns and directions can be duplicated exactly for subsequent jobs. 

There are five maps available:
►Boundaries – application boundaries establish areas where 

product is and is not applied while using ASC or BoomPilot. 
On the Matrix Pro G, Matrix Pro GS or Aeros console, 
boundaries can be established in all guidance modes. One 
exterior boundary and up to five (5) interior boundaries can 
be stored at one time. A boundary cannot be drawn; it must 
be established on a console or provided in a third-party 
prescription map.

►Guidelines – AB guidelines, Azimuth guidelines, next pass 
guidelines, and NextRow guidelines are each available 
depending on the current guidance mode on the Matrix Pro G, 
Matrix Pro GS or Aeros console. Up to 25 established 
guidelines can be stored in the console per job. 

►Prescription Maps – map files consisting of geospatially 
defined application rate zones which provide information to 
the rate controller for use in applying product.

►Applied Data – applied data is a record of areas covered by 
the implement and how much and where product has been 
applied 

►Tip Faults – when a Tip Flow Monitor Kit is present on an 
Aeros system, a Tip Flow Monitor is available. After the tips 
are balanced, the system will monitor all the tips and their the 
flow rate if their respective boom section is turned on. The 
flow rate of each tip must be within the percentage range. If 
any tip is outside this range, an error will be generated, and 
the user will need to inspect the tip that is at fault. These faults 
are recorded and available to be viewed on a map.
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Map Screen Overview
The mapping utility allows viewing and editing of many map details. 
Each map offers a different set of options specific to that map type.

•	 Map image

–– Zoom In/Zoom Out – use the mouse wheel

–– Move Map – right-click and drag

•	 Map Editing Tools

–– �Guidelines – adds new straight AB or curved AB 
guidelines; edit existing guidelines; measure distance on 
the map

–– �Prescription Maps – cut existing boundary or region into 
new regions; fill region; measure distance on the map

•	 Location – displays the Longitude/Latitude coordinates of the 
cursor on the map

•	 Bottom Tabs

–– �Guidelines – lists each guideline; when scrolled over, 
guideline is highlighted on the map; when selected, 
guideline details are displayed

–– �Prescription Maps – lists each prescription area; when 
scrolled over, area is highlighted on the map; when 
selected, map and region details are displayed

–– �Applied Maps – lists each applied area; when scrolled over, 
applied area(s) is highlighted on the map; when selected, 
map and region details are displayed

–– �Tip Faults – lists each tip fault; when scrolled over, tip fault 
is highlighted on the map; when selected, fault details are 
displayed

•	 Map and Region Details

–– �Guidelines – allows editing of the name or to delete the 
selected guideline

–– �Prescription Maps – displays map details; allows editing to 
region details and minimum/maximum rate colors

–– �Applied Maps – displays map details; allows editing to 
region details and minimum/maximum rate colors

–– �Tip Faults – displays fault name

•	 Save Map Profile – when unsaved changes have been 
detected, click the Save  button.

Figure 73: Prescription Maps Example Overview

Bottom Tabs

Location 

Map Image
Map and Region Details

Map Editing Tools

Save Map Profile
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Menu Bar

Boundary Map
The Boundary Map menu provides basic tools for editing maps.

Figure 74: Boundary Map Menu

Table 10: Boundary Map Menu Options

Icon Description
Measure Distances – measures distances on the 
map

Guidelines Map
The Guidelines Map menu provides basic tools for editing maps.

Figure 75: Guidelines Map Menu

Table 11: Guidelines Map Menu Options

Icon Description
Create New Staight Line – draws two points 
connected by a straight line
Create New Curved Line – draws curved line that 
can have multiple points connecting on a curve or 
with straight lines
Edit Line – changes the location of points on a 
guideline
Measure Distances – measures distances on the 
map

Prescription Map
The Prescription Map menu provides basic tools for creating and 
editing maps.

Figure 76: Prescription Map Menu

Table 12: Prescription Map Menu Options

Icon Description
Cut Region – draws a region to be removed from 

Fill Region – XXXX

Measure Distances – measures distances on the 
map

Applied Data Map
The Applied Data Map menu provides basic tools for editing maps.

Figure 77: Applied Data Map Menu

Table 13: Applied Data Map Menu Options

Icon Description
Measure Distances – measures distances on the 
map

Tip Faults Map
The Tip Faults Map menu provides basic tools for editing maps.

Figure 78: Tip Faults Map Menu

Table 14: Tip Faults Map Menu Options

Icon Description
Measure Distances – measures distances on the 
map
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BOUNDARY MAP

Application boundaries establish areas where product is and is not applied while using ASC or BoomPilot. On the Matrix Pro G, Matrix Pro GS 
or Aeros console, boundaries can be established in all guidance modes. One exterior boundary and up to five (5) interior boundaries can be 
stored at one time. A boundary cannot be drawn; it must be established on a console or provided in a supported format prescription map.

►View – select to view the boundary(s) on a map and use the Measure Distances tool
►Delete – select to delete all boundaries in the current job profile

View
Select to view the boundary(s) on a map.

Figure 79: View

Figure 80: Boundary Map

 Measure Distances Tool
Select to measure distances on the boundary map.

Figure 81: Measure Distances Tool

Delete
Select to delete all boundaries in the current job profile

Figure 82: Delete
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GUIDELINES MAP

AB guidelines, Azimuth guidelines, next pass guidelines, and NextRow guidelines are each available depending on the current guidance 
mode on the Matrix Pro G, Matrix Pro GS or Aeros console. Up to 25 established guidelines can be stored in the console per job. 

►Add – select to open the existing boundary or map in the location of the deleted boundary to add new guideline information
►Edit – select to edit an existing guideline(s) on a map or add a straight AB or curved AB guideline(s)
►Delete – select to delete all guidelines in the current job profile

Add or Edit
Select  Add  to open the existing boundary or map in the location of 
the deleted boundary to add new guideline information.

Select  Edit  to edit an existing guideline(s) on a map or add a 
straight AB or curved AB guideline(s).

Figure 83: Add

Figure 84: Edit

 New Straight AB Guideline
A straight line will have two point connected by a straight line.

1.	 Select Map->New Straight Line or CREATE NEW STRAIGHT 
LINE button .

2.	 Click Point A on the map.
3.	 Click Point B on the map. 
4.	 Press Enter key on the keyboard.
5.	 Rename the guideline, if desired.
6.	 Select SAVE CHANGES button .
Figure 85: Straight AB Guideline Tool







 
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 New Curved AB Guideline
A curved line can have multiple points that can connect on a curve or 
with straight lines. Curved guidance is recommended not to exceed 
30° within the AB guideline. While working in a bounded area, the 
guidance pattern extending beyond the established A Point Bs will be 
straight-line guidance.

1.	 Select Map->New Curved Line or CREATE NEW CURVED LINE 
button .

2.	 Click Point A on the map.
–– �To create a straight line between two points, click and 
release the point. 

–– �To create a curved line between two points, click and hold 
the curser while drawing the curved line. 

3.	 To set the Point B, press Enter key on the keyboard.
4.	 Rename the guideline, if desired.
5.	 Select SAVE CHANGES button .
Figure 86: Curved AB Guideline Tool











 Edit Guideline
1.	 Select Map->Edit Line or EDIT LINE button .
2.	 Select point on existing line.

–– �Straight AB Line – click and drag Point A or Point B to the 
new location on the map.

–– �Curved AB Line – click and drag any point on the line to 
the new location on the map.

3.	 Select SAVE CHANGES button .
Figure 87: Edit Guideline Tool



Original

Edited







 Measure Distances Tool
Select to measure distances on the guideline map.

Figure 88: Measure Distances Tool
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Guideline Details
The guideline details section gives the options to rename or delete 
selected guidelines. Click on a guideline from the Bottom Tabs to 
rename or delete.

To rename a guideline:
1.	 Click on a guideline from the Bottom Tabs.
2.	 Click in the Name box to edit the name.
3.	 Select SAVE CHANGES button .

To delete a guideline:
1.	 Click on a guideline from the Bottom Tabs.
2.	 Click  Delete Item .
3.	 Select SAVE CHANGES button .
Figure 89: Guideline Details






Delete
Select to delete all guidelines in the current job profile.

Figure 90: Delete

PRESCRIPTION MAPS

Prescription Map Files consist of geospatially defined application 
rate zones which provide information to the rate controller for use in 
applying product. To add a prescription map to a Job the user may 
import the map from a supported format or manually create the map 
using the drawing tools of Fieldware Link.

NOTE: USE FIELDWARE CONVERT
If a prescription map does not need to be edited, 
only to be converted to a TeeJet format to be used 
in a TeeJet job, use Fieldware Convert instead of 
Fieldware Link.

Fieldware Convert can be downloaded at  
www.teejet.com/support/software.

Prescription map data is loaded into the console when properly 
placed into a valid TeeJet Job. 

Only single channel/single product prescriptions are supported.  

Multi-product VRA is not supported.

Prescription application only works for Aeros and Matrix Pro GS 
consoles connected to a controller supporting VRA.

►Import – select to load an existing prescription map from a 
supported format

►Add – select to manually create a prescription map based on 
an existing boundary in the Job

►Edit – select to edit a prescription map already existing within 
a Job

►Delete – select to delete the existing prescription map
Figure 91: Prescription Map Options
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Import 
Using Fieldware Link is one of two methods allowed to import a 
prescription map into a job. If a prescription map does not need to be 
edited, only to be converted to a TeeJet format to be used in a TeeJet 
job, use Fieldware Convert instead of Fieldware Link.

To import a prescription exported from an Ag GIS/FMIS requires the 
following:

•	 The user has properly created a Job into which the prescription 
map file can imported

•	 The format is supported by Fieldware Link

–– �TeeJet Application Rate Management (*.arm)

–– �ESRI™ Shapefile (*.shp)

–– �ISOXML (taskdata.xml)

•	 The prescription file contains only a VRA application for a single 
channel/product only

For more details on each of these file types, see “Appendix B – 
Supported FMIS Data Details”.

ISOXML/ARM

When converting an ISO-11783 ISOXML or Mid-Tech/TeeJet ARM 
file, use the following procedure:
1.	 Open a new or existing Job that does not already have a 

prescription map associated with it.
2.	 Click Prescription Map  Import .
3.	 Select the Map File Type.

►TeeJet Application Rate Management
►ISOXML

4.	 Highlight the map file; click  Open .
5.	 Manually edit the map as needed.
Figure 92: Import



Figure 93: Import Prescription Map







SHP

When converting an ISO-11783 ISOXML or Mid-Tech/TeeJet ARM 
file, use the following procedure:
1.	 Open a new or existing Job that does not already have a 

prescription map associated with it.
2.	 Click Prescription Map  Import .
3.	 Select the Map File Type  Shapefile .
4.	 Highlight one or more map files (use the Shift and Control keys + 

mouse clicks to select one or more files); click  Open .
5.	 Adjust Shape Database Field attributes accordingly. See Shape 

Database Fields Variation 1, Variation 2 or Variation 3 as 
examples; click  Submit .

6.	 Manually edit the map as needed.
Figure 94: Import



Figure 95: Import Prescription Map






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Shape Database Fields
A user MUST identify three things when converting a SHP file; the 
product’s Name, the product’s application Units (e.g. pounds/acre), 
and the product’s application rate values.

Variation 1
DBF field names match those pre-defined by the TeeJet Shape 
Import instructions; “Prod_Name”, “Prod_Unit”, “Prod_Rate”

This results in an “autofill” of the Product information fields.

Figure 96: Field Names Match Pre-defined Information



Variation 2
DBF field names DO NOT match those pre-defined by the TeeJet 
Shape Import instructions.

1.	 Select proper field names identifying the Field’s “Product Name”, 
“Unit” and “Rate” data.

NOTE:	 In this case, if all SHP files have the same DBF field names 
(column names) then when multiple files are selected for 
conversion, after establishing them once, the same choices 
are used on subsequent conversions when more than one 
SHP has been selected for conversion.

Figure 97: Field Names DO NOT Match Pre-defined Information



Variation 3
Only a single DBF Field containing the Product Rates is provided.

Identify the Field’s “Product Name” and “Unit” data:
1.	 Select Product Name:  Mix  to change selection to  Custom .
2.	 Enter a custom product name in the Custom Name text box.
3.	 Select Units:  Mix  to change selection to  Custom .
4.	 Select an application unit type for the product from the drop-

down menu.
The “Rate” drop down dialogue automatically chooses the DBF field 
named Mix to get the rate values.

NOTE:	 This variation has extensions if more than one DBF field 
(column) exists but only one of them contains the required 
information.

Figure 98: Single Field Containing the Product Rates


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Add or Edit
Add – Manually Creating a Prescription
Fieldware Link allows the user to manually create prescription rate 
zones based on an existing boundary. 

•	 User must first create a job and add a boundary file to it; 
without the boundary file, Fieldware Link does not know what 
coordinates to use when creating the polygon rate zones

•	 User is restricted to a maximum of 255 different rates in the 
prescription file

•	 User can create as many polygons as they desire so long as the 
number of different rates to apply is 255 or less

	 NOTE: �each polygon must have a rate assigned. Different 
polygons can have the same rate which allows for 
more polygons than rates.

Select  Add  to open the existing boundary to add prescription 
information to the existing boundary.

Figure 99: Add Prescription Information to Existing Boundary

Edit – Editing an Existing Prescription
Fieldware Link allows the user to manually edit existing prescription 
files and individual rate polygons. This could aid the user if there is a 
need to change rate values or delete application polygons from the 
prescription. Or if the application grid imported was not trimmed to 
the boundary.

Select  Edit  to edit the existing prescription map.

Figure 100: Edit

 Cut Region
Cut region allows a boundary or an existing region on the map to be 
divided or a internal polygon to be created.

To divide a region:
1.	 Select Map->Cut Region or CUT REGION button .
2.	 Using the left mouse button, draw a division line across the 

boundary or region.
3.	 A blank region tab will appear in the Bottom Tabs. 
4.	 Select the new region tab to rename the region, if desired, using 

the Region Details options.

5.	 Select SAVE CHANGES button .
Figure 101: Cut Region Tool – Divide Region











To create an internal polygon:
1.	 Select Map->Cut Region or CUT REGION button .
2.	 Using the left mouse button, draw an Internal Polygon out of an 

existing region.
–– Internal Polygons cannot extend over multiple regions.

–– �Internal Polygons will not have any Region Properties until 
it has been filled. See the Fill Region section for details. 

3.	 Select SAVE CHANGES button .
Figure 102: Cut Region Tool – Internal Polygon






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 Fill Region
Fill region allows an internal polygon on the map to be changed to a 
designated region.

1.	 Select Map->Fill Region or FILL REGION button .
2.	 Click on the unfilled internal polygon.
3.	 A  New Zone  tab will appear in the Bottom Tabs. 
4.	 Select the new region tab to rename the region, if desired, using 

the Region Details options.
5.	 Select SAVE CHANGES button .
Figure 103: Fill Region Tool











 Measure Distances Tool
Select to measure distances on the prescription map.

Figure 104: Measure Distances Tool

Color Range Selection
Above Map Details, select corresponding display colors for mapping 
maximum/minimum rate limits. Using the Min/Max selector will 
override any regional color selections.

1.	 Select:
►Minimum Rate Color – used to set the color for the minimum 

rate
►Maximum Rate Color – used to set the color for the maximum 

rate
2.	 Select  Refresh Map .
Figure 105: Color Range Selection Options

 

 

Map Details
The map details section displays applied data details including 
total area covered, number of application rate regions, total product 
applied, tank requirements and if tank refills are necessary.

Figure 106: Map Details
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Region Details
The region details section gives the options to rename, override 
individual region color, adjust the region’s application rate, delete a 
region or internal region, or view information including region area 
and region’s total applied product. Click on a region from the Bottom 
Tabs to rename, recolor, adjust rates or delete a region or internal 
region.

To rename a region:
1.	 Click on a region from the Bottom Tabs.
2.	 Click in the Name box to edit the name.
3.	 Select SAVE CHANGES button .

To adjust the region’s application rate:
1.	 Click on a region from the Bottom Tabs.
2.	 Click the Target Application Rate UP/DOWN buttons to edit the 

rate.
3.	 Click  Refresh Map  to update the minimum/maximum colors to 

reflect the rate change.
4.	 Select SAVE CHANGES button .

To delete a region:
1.	 Click on a region from the Bottom Tabs.
2.	 Click  Delete Item .
3.	 Select SAVE CHANGES button .

To delete an internal polygon:
1.	 Click on the internal polygon’s Bottom Tab or a region from the 

Bottom Tabs that contains the internal polygon.
2.	 Click  Delete Item  or  Delete (xxx points)  in the Internal 

Polygons section.
3.	 Select SAVE CHANGES button .

Figure 107: Region Details






Delete
Select to delete all prescription map data in the current job profile.

Figure 108: Delete
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APPLIED DATA MAP

Applied data is a record of areas covered by the implement and how much and where product has been applied.

►Export – select to export the applied data record to an XML file to be used for other external mapping options
►View – select to view the applied data on a map and use the Measure Distances tool
►Delete – select to delete all applied data in the current job profile

Export
Select to export the applied data record to an XML file to be used for 
other external mapping options.

Figure 109: Export

View
Select to view the applied data on a map and use the Measure 
Distances tool.

Figure 110: View

Figure 111: Applied Data Map

 Measure Distances Tool
Select to measure distances on the applied data map.

Figure 112: Measure Distances Tool
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Color Range Selection
Above Map Details, select corresponding display colors for mapping 
maximum/minimum rate limits. Using the Min/Max selector will 
override any regional color selections.

1.	 Select:
►Minimum Rate Color – used to set the color for the minimum 

rate
►Maximum Rate Color – used to set the color for the maximum 

rate
2.	 Select  Refresh Map .
Figure 113: Color Range Selection Options

 

Map Details
The map details section displays applied data details including 
total area covered, number of application rate regions, total product 
applied, tank requirements and if tank refills are necessary.

Figure 114: Map Details

Region Details
The region details section displays name, region color, region area, 
region application rate and region’s total applied product. Click on a 
region from the Bottom Tabs to see details.

Figure 115: Region Details



Delete
Select to delete all applied data in the current job profile.

Figure 116: Delete
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TIP FAULTS MAP

When a Tip Flow Monitor Kit is present on an Aeros system, a Tip Flow Monitor is available. After the tips are balanced, the system will 
monitor all the tips and their the flow rate if their respective boom section is turned on. The flow rate of each tip must be within the percentage 
range. If any tip is outside this range, an error will be generated, and the user will need to inspect the tip that is at fault. These faults are 
recorded and available to be viewed on a map.

►View – select to view the tip faults on a map and use the Measure Distances tool
►Delete – select to delete all tip faults in the current job profile

View
Select to view the tip faults on a map.

Figure 117: View

Figure 118: Tip Faults Map

 Measure Distances Tool
Select to measure distances on the boundary map.

Figure 119: Measure Distances Tool

Delete
Select to delete all tip faults in the current job profile

Figure 120: Delete
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MAPS ON A CONSOLE

GNSS-based product application mapping is available on the 
Matrix Pro GS or Aeros in Vehicle View or Field View, in any 
guidance mode when a rate controller is on the system. Mapping 
can record areas covered by the implement (Coverage) or how much 
product has been applied and where (Application), and can direct 
single- and variable-rate product application (Preset Target Rate and 
Prescription, respectively).

►Coverage Map [viewable as part of the application map] – 
shows areas covered by the implement, regardless of whether 
product was applied

►Prescription Map – pre-loaded map that provides information 
to the rate controller for use in applying product

►Application Map – shows how much product has been applied 
and where, using color to indicate level in proportion to preset 
or automatically set maximum and minimum levels

►Target Rate Map [not availble to be seen in Fieldware Link] – 
shows the application rate that the rate controller attempted to 
achieve at each location

Boundaries, guidelines, applied data, and prescription mapping can 
be copied from one job to another, eliminating the need to re-record 
field boundaries and information. The ability to reuse guidelines 
means work patterns and directions can be duplicated exactly for 
subsequent jobs. 
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APPENDIX A – CONFIGURATION SETTINGS
This appendix lists the Matrix Pro console, Aeros console, and 
Fieldware Link software menu settings, and also provides the 
following:

•	 Settings that can be made in the Matrix Pro console, Aeros 
console, or using the Fieldware Link software.

•	 Settings that are included when exported to a profile from the 
Matrix Pro console, Aeros console, or using the Fieldware Link 
software.

Symbol Key
In the following tables, these symbols indicate whether settings are 
available during an active Job:

 Available
 Not Available
◄ Retained from console with profile
► Retained from Fieldware Link with profile

Configuration Settings

 Configuration Settings
Can be edited in

Saved to  
exported profile in

Matrix Pro Aeros 9040
Fieldware 

Link Matrix Pro Aeros 9040
Fieldware 

Link

Implement

Machine Type...........................................................................
GNSS Antenna Height..............................................................
Implement Type........................................................................
Symmetric Implement Layout...................................................
Multiple Section Output Modules..............................................
Number of Implement Sections................................................
Guidance Width........................................................................
Application/Working Width........................................................
Droplet Size Monitor.................................................................






v4.33 ►













































◄



◄



◄

Tip Selection
Current Tip......................................................
Tip Preset.......................................................
















◄
◄

Tip Spacing...............................................................................
Ground Speed Override...........................................................
Applied Alert.............................................................................
Entry Time................................................................................
Exit Time...................................................................................
Allow BoomPilot In Reverse.....................................................
BoomPilot Start Mode...............................................................
BoomPilot Icon.........................................................................
Reverse Signal Delay...............................................................












◄ v4.21






































◄
◄
◄
◄
◄
◄
◄
◄
◄

Straight 
Mode

In-Line Implement Offset Direction.................
In-Line Implement Offset Distance.................
Lateral Implement Offset Direction.................
Lateral Implement Offset Distance.................
Connection Point In-Line Offset Direction......
Connection Point In-Line Offset Distance.......
Connection Point Lateral Offset Direction......
Connection Point Lateral Offset Distance.......
Overlap...........................................................
Delay On/Off Times........................................

















v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►








































◄
◄
◄
◄



Spreader 
Mode

Setup Type: TeeJet.......................................
Antenna to Disks Distance.............................
Lateral Implement Offset Direction.................
Lateral Implement Offset Distance.................
Overlap...........................................................
Delay On/Off Times........................................
Spread Offset Distance..................................
Section Offsets...............................................
Section Lengths..............................................




























































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 Configuration Settings
Can be edited in

Saved to  
exported profile in

Matrix Pro Aeros 9040
Fieldware 

Link Matrix Pro Aeros 9040
Fieldware 

Link

Implement
(continued)

Spreader 
Mode 
(continued)

Setup Type: OEM..........................................
Antenna to Disks Distance.............................
Lateral Implement Offset Direction.................
Lateral Implement Offset Distance.................
Start/Stop Distances.......................................
Section Start/Stop Offsets..............................











































Staggered 
Mode

In-line Section 1 Offset Direction....................
In-line Section 1 Offset Distance....................
Lateral Implement Offset Direction.................
Lateral Implement Offset Distance.................
Overlap...........................................................
Delay On/Off Times........................................
Section Offsets...............................................

















































Mapping and 
Guidance

Mapping Location..................................................................... v4.31 ► v4.31 ►    ◄
Location Name...............................................
Mapping Location In-Line Offset Direction.....
Mapping Location In-Line Offset Distance......
Mapping Location Lateral Offset Direction.....
Mapping Location Lateral Offset Distance......

v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►

v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►



















◄
◄
◄
◄
◄

Guidance Width........................................................................
Guidance Sensitivity.................................................................
Display Mode............................................................................
LED Spacing.............................................................................
External Lightbar......................................................................
External Lightbar LED Brightness............................................
External Lightbar Text Brightness.............................................
External Cross Track................................................................
External Swath Number............................................................
External Speed.........................................................................
External Actual Rate.................................................................
External Target Rate.................................................................
External Applied Product..........................................................




v4.11 ►
v4.11 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►


v4.11 ►



v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►
v4.31 ►












































◄
◄
◄
◄
◄
◄
◄
◄
◄
◄
◄
◄

Sensors
IOM Pressure 
Sensor

Maximum Pressure Rating............................
Low Pressure Alarm......................................
High Pressure Alarm......................................

























Tip Flow 
Monitor

Tip Alarm Percentage...............................................................
Tip Alarm Delay........................................................................
Number of Sections..................................................................
Number of Tips per Section 1–30.............................................
Tip Balance Percentage...........................................................
Tip Flow Monitor Balance.........................................................




































◄
◄
◄ 
◄ 
◄ 
◄

ISOBUS

Machine Speed Broadcast.......................................................
Navigation Speed Broadcast....................................................
Ground Speed Broadcast.........................................................
Speed Broadcast......................................................................
Time/Date Broadcast................................................................
Universal Terminal (UT) Number..............................................
Task Controller (TC) Number....................................................
Number of UT Object Pools......................................................
Number of Isobus Control Functions........................................











v4.31 ►
v4.31 ►
v4.31 ►
 ◄v4.21
v4.11 ►
v4.11 ►
v4.11 ►
v4.11 ►
v4.11 ►































◄
◄
◄
◄
◄
◄ 
◄ 
◄ 
◄
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 Configuration Settings
Can be edited in

Saved to  
exported profile in

Matrix Pro Aeros 9040
Fieldware 

Link Matrix Pro Aeros 9040
Fieldware 

Link

Control 
Channels

Device Setup Dual Control Module (DCM) 1.......................
Product Control Channel 1............................
TankMatic......................................................





◄ v4.21
◄ v4.21
◄ v4.21

















Product Control Channel 1*
TankMatic Sensor Type..................................................

Minimum Tank Content..................................
Maximum Tank Content.................................
Automatic Filling Offset..................................






◄ v4.21
◄ v4.21
◄ v4.21
◄ v4.21





















Product

Product Name...........................................................................
Actual Tank/Bin Amount............................................................
Target Application Rate Preset #1–3........................................
Tip Constant.............................................................................
Product Density........................................................................
Application Rate Step...............................................................
Maximum Rate Color................................................................
Minimum Rate Color.................................................................
Color Range.............................................................................
Applied Rate Mapping Upper Limit...........................................
Applied Rate Mapping Lower Limit...........................................














◄ v4.21
◄ v4.21


◄ v4.21
◄ v4.21





















►











►












◄
◄ 
◄ 
◄ 
◄ 
◄ 
◄

 AutoSteer 

Assisted/Auto Steering Enabled/Disabled................................      ◄
Valve Setup Valve Type......................................................

Valve Frequency.............................................
Minimum Left/Right Duty Cycle......................
Maximum Left/Right Duty Cycle.....................


























◄
◄
◄
◄

Steering 
Settings 

Coarse Steering Adjustment...........................
Fine Steering Adjustment...............................
Deadband.......................................................
Lookahead......................................................


























◄
◄
◄
◄

Valve Test.................................................................................      ◄
Valve Diagnostics.....................................................................      ◄
Options Steering Wheel Sensor...................................      ◄
Steering 
Angle 
Sensor 

Enabled/Disabled...........................................
Sensor Calibration..........................................
On Line Calibration.........................................





















◄
◄
◄

Tilt Correction
Enabled/Disabled.....................................................................
Field Level................................................................................
















◄
◄
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APPENDIX B – SUPPORTED FMIS DATA DETAILS
The Fieldware Link application only supports the following FMIS 
prescription file formats:
•	 ISO-11783 ISOXML
•	 Mid-Tech/TeeJet ARM
•	 ESRI Shapefile (SHP)

ISO-11783 Part 10 ISOXML - “TASKDATA”
Fieldware Link can convert version 2.0 ISOXML prescription data 
into TeeJet Job format if it conforms to the following rules:

►�Prescription data are single product only.
•	 TASKDATA.xml files with multiple products assigned to a 

Treatment zone will only select and convert the first one 
encountered.

►�TASKDATA.xml files may contain multiple single product 
prescription tasks (<TSK’s).
•	 Each <TSK found during the conversion process will get placed 

into a new unique Job within the TeeJetData folder structure.

►TASKDATA.xml prescription data supports the following:
•	 Grid Type 1

•	 Polygon based

•	 Grid Type 2 with less than 255 unique rate values found in the 
Task’s PDV elements.

►�No limit to the number of polygons as long as the Grid Type 1/
Polygon unique rate limit of 255 is followed.

►�Partfield Boundary elements are supported for all Part 10 versions 
up to 4.0.
•	 This means the <PFD element’s boundary description is 

supported for single bounding polygons with multiple parts or for 
multiple single boundary polygons assigned to a single <PFD 
element.

►�”Straight Rate” Treatment Zone prescriptions that do not contain 
a <PLN or <GRD reference within the <TSK - <TZN are NOT 
supported.
•	 Therefore, if a valid TASKDATA file includes a <TSK with a 

<TZN and uses the implied boundary polygon of the <PFD 
object, Fieldware Link will NOT attempt to convert it. Users must 
export a valid <TSK with a valid <TZN and <PLN.

►�Only “Mass” and “Volume” based prescription Unit types are 
supported.
•	 DDI’s 0001 and 0006 in the <PDV elements

•	 It should be understood that if other DDI’s are found they will be 
converted and a Job created, it is that the target TeeJet console 
will NOT understand what to do as only DDI’s 0001 and 0006 
are handled.

►�No attempt is made to fully comply with the 11783 Part 10 
workflow.
•	 Coding data are NOT maintained.

•	 This conversion is for prescription file support on the target 
TeeJet console only.

•	 Any generated Job tasks will not push their data into the 
console’s system TASKDATA.xml file, and therefore, you should 
NOT expect to have all data when the Job is transferred out of 
the system after completion.

Mid-Tech/TeeJet ARM
Fieldware Link can convert Mid-Tech/TeeJet ARM data into TeeJet 
Job format if it conforms to the following rules:

►�Single Product only
•	 If more than one product exists within the ARM file it will be 

ignored.

►�Must contain less than 255 unique rate values.
•	 No limit to the number of polygons.

ESRI Shapefile (SHP)
Fieldware Link can convert ESRI Shapefile (SHP) data into TeeJet 
Job format if it conforms to the following rules:

►�Single Product only.
•	 Single Product SHP files must contain less than 254 unique rate 

values. (see TASKDATA.xml limits above for details)

•	 No limit exists on the number of polygons, same as with 
TASKDATA.xml.

►�SHP data must be in WGS84 Latitude-Longitude coordinates.

►�SHP data must exist as a group of files of the same name and 
differing extensions.
•	 Fieldware Link MUST have:

•	 .SHP
•	 .SHX
•	 .DBF

•	 The projection file (.PRJ) is optional, however, if present can 
only exist as the single form for GEOGCS WGS84.

•	 GEOGCS[“GCS_WGS_1984”,DATUM[“D_
WGS_1984”,SPHEROID[“WGS_1984”, 6378137, 
298.257223563]],PRIMEM[“Greenwich”, 
0],UNIT[“Degree”,0.017453292519943295]]

•	 All other SHP files will be ignored.



►�The .DBF file must contain at least one field (table column) of 
numeric data linked to the .SHP polygons.
•	 If more than one field of numeric data exists, the user will only 

be allowed to choose one.
•	 If a Product Field exists with different Product names defined, 

only the first encountered name will be accepted.

►�The recommended .DBF file structure should contain three fields 
with the following labels:
•	 Prod_Name
•	 Prod_Unit
•	 Prod_Rate

See Appendix C for more details

►�The Fieldware Link SHP file function does not handle Boundary 
Polygons in SHP format.
•	 Such data will be ignored.

►�The Jobs created from SHP files are the prescriptions only. No 
boundaries.

Supported DBF Unit Type Abbreviations
The list below is strictly defined. The unit type column in the DBF file 
must match one of the below exactly in order to be utilized.

Volume
MetersCubed
Gallons
ImpGallons
FluidOunces
Liters
Quarts
FeetCubed
YardCubed

Mass
Grams
Pounds
Kilograms
Ounces
Ton
Tonne

Area
MetersSquared
Acres
Hectares
KilometersSquared
FeetSquared
Feet1KSquared
MilesSquared

The unit type must be a ratio 
separated by a ‘/’ character. 
Some examples of proper unit 
types are:

–– Gallons/Acres
–– Kilograms/Hectares
–– Liters/MetersSquared 
–– etc...

Supported DBF Table Descriptions
Table 1: Example of minimal populated DBF in pseudo-table format:

Prod_Rate
15
15
0
15

The preferred contents of the DBF file should indicate the Product 
Name, Product Unit Type and Product rate information as pre-
defined fields.

Table 2: Example of completely populated DBF in pseudo-table 
format:

Obj_ID Shape
Prod_
Name Prod_Unit Prod_Rate

1 polygon Roundup 
Pro™

Gallons/
Acres

15

2 polygon Roundup 
Pro™

Gallons/
Acres

15

3 polygon Roundup 
Pro™

Gallons/
Acres

0

4 polygon Roundup 
Pro™

Gallons/
Acres

15

The ObjID and Shape fields in the above table are surrogates for the 
ESRI “Attribute Table” view of the .DBF file.

Refer to Appendix B for Unit Type designators within the DBF file.

Supported Custom Unit Type Abbreviations
The list below is directly taken from Bugzilla PR 10400. It applies 
only to custom unit types, and the values may be translated.

Volume
Liters/Hectare
Liters/Acre
Gallons/Acre
Gallons/1k SqFt
fl oz/Acre
fl oz/1k SqFt

Mass
Kg/Hectare
Kg/Acre
Metric Ton/Hectare
Pounds/Acre
Pounds/1k SqFt
Ton/Acre (equal to "short 
tonnes/Acres")
Ton/Hectare (equal to "short 
tonnes/Hectares")
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APPENDIX C – ISO-11783 TASKDATA.XML EXAMPLE

Fieldware Link and Matrix PRO GS Guide 
Instructions for using Fieldware Link to prepare jobs for VRA applications using ISOXML prescription files, Matrix Pro GS consoles, and 
compatible rate controllers. While Fieldware Link can be used to create detailed Machine profiles that can be transferred into Matrix Pro 
GS consoles, these instructions detail the minimum requirements to create jobs in Fieldware Link. The basic Machine profiles used in these 
examples will be transferred to the USB Drive when the VRA jobs are exported, but they should not be transferred/loaded into the Matrix Pro 
GS console. As an alternative, power users are welcome to build complete Machine profiles in Fieldware Link, use those profiles to create 
VRA jobs, and load both the Machine profiles and jobs into their Matrix Pro GS console.

Requirements:

•	 The TASKDATA.xml file to be imported can only contain a single (1) TSK.

–– If the TASKDATA.xml file contains more than one TSK, use Fieldware Convert to first create the desired Jobs. 

•	 Please use Fieldware Link v5.02 or later for this work.

•	 It is recommended that the Matrix Pro GS console be running v4.30 or later.

•	 The Matrix Pro GS must be unlocked for the function ‘Rate Control’.

•	 The Matrix Pro GS setting Configuration->Data->Options\Job Mode must be set to ‘Advanced’ in order to allow VRA applications.

1.	 BUILD A BASIC DRY FERTILIZER AND/OR BASIC LIQUID APPLICATOR/SPRAYER MACHINE PROFILE
NOTE:	 The “Application Type” MUST be set properly prior to importing the prescription file. 
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2.	 BUILD THE CLIENT/FARM/FIELD STRUCTURE 
All jobs in Fieldware Link are organized in the industry standard Client/Farm/Field hierarchy. Build this structure as shown below, naming 
each Object in a manner that is easy for the user to recognize. Repeat as necessary for multiple Clients, Farms, and Fields. None of the 
values within each of the Client/Farm/Field tabs are critical or required to build a VRA job.

3.	 CREATE A JOB 
Create a job within the appropriate field. It is critical at this point that the ‘Machine Settings’ selected is appropriate for the application 
planned. If the application will be for a dry fertilizer material, the machine selected from Step 1 above must be a dry fertilizer (granular) 
machine. If the application will be for a liquid material, the machine selected from Step 1 above must be a liquid applicator/sprayer.
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4.	 IMPORT THE ISOXML PRESCRIPTION FILE 
Click on the ‘Prescription Map’ ‘Import’ button and navigate in Windows to the location where you have saved the ISOXML prescription 
files sent from your FMIS provider.  Be sure to select ‘ISOXML (taskdata.xml)’ in the drop-down box to the right of the ‘File name’ selection 
box. The file you select will be named TASKDATA.XML.   
Once selected, click on ‘Open’.

NOTE:	 ISOXML files are commonly sent from the provider in a zipped file format.  It is critical that you unzip (Extract) the zipped files before 
attempting to import them into Fieldware link.  If you see the message ‘The map you are attempting to open has no useable data’ it is 
quite possibly because the files you are importing are still in a zipped format. Unzip (Extract) the files and try the import again.
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5.	 VERIFY THAT THE ISOXML FILE IMPORTS CORRECTLY AND THAT THE RATES ARE AS EXPECTED 
The imported map appearance will vary depending on how it was produced by your FMIS provider. Click on the tabs at the bottom of the 
map, and verify that the rates shown in the right side panel are as expected. 

6.	 PREPARE TO EXPORT THE JOB TO A USB DRIVE 
Click on the ‘Port Profiles’ to open the port window. Select the drive letter for the USB Drive (Thumb Drive) location on your computer that 
you want to port the job to. Be very sure to select ‘Aeros or Matrix 570/840 v4.00’ in the ‘Console’ drop-down box. Click OK.
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7.	 EXPORT JOB TO USB DRIVE 
In the left pane select the job that you wish to export to the USB drive and click on the single right pointing brown arrow.

The job and appropriate Machine profile will now show in the right pane. Be very careful to click on the ‘Done’ button in the lower right corner 
of the right pane before removing the USB drive from the computer.

The following steps assume that the Matrix Pro GS already meets all the requirements listed at the start of this document, and that the GPS/
GNSS and Implement configurations have already been set correctly for the application and implement being used.

8.	 IMPORT JOB INTO MATRIX PRO GS CONSOLE 
Insert the USB Drive in the Matrix Pro GS console and navigate to Configuration->Data->Job Data->Transfer, and copy the job from ‘USB 
Storage’ to ‘Internal Storage’

9.	 CONFIGURE MATRIX PRO GS FOR VRA (THIRD-PARTY RATE CONTROL) 
Navigate to Configuration->Third-Party Rate Control, enable Third-Party Rate Control, and set each of the parameters as required for the 
controller. Your TeeJet contact may have to assist with this.

10.	BEGIN APPLICATION 
From the home page select the imported job from the ‘Job’ drop-down box, and begin the application.
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•	 Enhanced data organization with Fieldware Link application

–– Reuse guidelines and/or boundaries

–– Input job details such as names or images

–– Setup machine settings for specific vehicles and implements

–– �Access and edit boundary, guideline, prescription, applied data 
and tip fault maps
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